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3D Slicer version 4 (Slicer4.1)

An end-user application for
image analysis

An open-source
environment for software
development

A software platform that is
both easy to use for clinical
researchers and easy to
extend for programmers



Slicer Modules

« Command Line Interface (CLI):
standalone executables with limited input/
output arguments

» Scripted Modules (Python):
recommended for fast prototyping

 Loadable Modules (C++ Plugins)
optimized for heaving computation



Slicer4 Highlights: Python

The Python console of Slicer4 gives access to
scene objects (MRML)
data arrays (volumes, models)
GUI elements that can be encapsulated in a
module

Processing Libraries: numpy, VTK, ITK,CTK



Slicer4 Scripted Modules

Python scripted modules allow more
interactive functionalities (eg ‘Flythrough’ in
Endoscopy module) and rapid prototyping

GUI based on Qt libraries accessed via Python

@ python’



Tutorial Goal

This tutorial guides you through the steps of
programming a HelloPython scripted module
for running a Laplacian filtering and
sharpening.

For additional details and pointers, visit the

Slicer Documentation page
http://wiki.slicer.org/slicerWiki/index.php/Documentation/4.0




Processing Examples in this
Tutorial

Manipulation
@ with numpy

3DSlicer

Image Data on

Disk (DICOM,

Nifti, nrrd...) . — A

S Manipulation

with VTK

Manipulation
with ITK

the Slicer Data Representation (Slicer CLI)

MRML: Medical Reality Markup Language,



Prerequisites

This course supposes that you have taken the
tutorial: “Slicer4 Data Loading and
Visualization”- Sonia Pujol Ph.D.

The tutorial is available on the Slicer4 101
compendium:

* Programming experience is required, and
some familiarity with Python is essential.



Course Material

Slicer4.1 version available at www.slicer.org

spgr.nhdr spgr.raw.gz = =2
(124 SPGR images)
HelloPython.py
HelloLaplace.py

Unzip the HelloPython.zip archive HelloSharpen.py



Course Overview

Part A: Exploring Slicer via Python

Part B: Integration of the HelloPython.py
program into Slicerd

Part C: Implementation of the Laplace
operator in the HelloPython module

Part D: Image Sharpening using the Laplace
operator



@ python’

Part A: EXPLORING SLICER VIA
PYTHON



Python in Slicer

Slicer 4 includes python 2.6.6 and a rich set of
standard libraries
Included: numpy, vtk, ctk, PythonQt, and
most of standard python library
Not included:
scipy (scientific tools for python),
matplotlib (python 2D ploting library),
ipython (interactive python)
and some other popular packages that we
have found difficult to package for distribution



Python Console in Slicer

¢-.“)‘) Q{{\Wo%_@/ E;tv Persistentkbghv v

@ ERR 5:0.00% 1

= O€lect View ->  Python Interactor to
™ launch the Python console of Slicer

| » About

| » The Main Window

| » Loading and Saving

| » Display

| » Mouse & Keyboard

| » Documentation & Tutorials

) SllcerQT—real

| » Acknowledgment

Python 2.6.6 (r266:84292, Mar 1 2012, 12:53:23)
[GCC 4.4.5] on linux2 %
>>>

v Data Probe

m




General Python Console Features

Command Line Editing:
Left/Right Arrow Keys, Home, End
Delete (Control-D)
Input History
Up/Down Arrow Keys
Command Completion
Tab Key st oo, e s



Add Volume Dialog

Yew Help
Modules: £\ Welcome to Slicer s m— {D 2 @ QO @ Z A 1| § v Persistent qa S v
@® ;L

£ - Select File -> Add Volume
Welcome

[Gtsy Load DICOM Data oo, Load Data
{#: Customize Slicer O Download Sample Data

v

About

v

The Main Window

v

Loading and Saving

v

Display

v

Mouse & Keyboard

v

Documentation & Tutorials

v

Acknowledgment

¥ Data Probe

-

None RAS: (125.0, -125.0, 1.0),



Add spgr.nhdr

y [ open |
Look in: ’E/home/pieper/Dropbox/O_work/HeIIoPython = ’ o (= O @ @ ‘]
P pieper Name v Size Type Date Modif
9 data " HelloPython-Progra...er-2012-03-08.pptx 7.7 MB pptx File 3/12/12 3::

| HelloPython-Program...utorial_spujol.pptx 6.5 MB pptx File 3/7/12 9:3!
| HelloPython.py 1 KB py File 9/9/10 3:0!

EMOPYLNON. 21D 6.4 MB zip File 3/12/12 3:.
4B spr.nhdr N 351 bytes nhdr File 9/9/10 3:0
e g 6.4 MB gz File 9/9/10 3:0°

Load the dataset spgr.nhdr
located in the directory
. HelloPython/

File name: | spgr.nhdr | 4 Open |

Files of :| All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *. *img *.p 2 || '
iles of type ’ ( r *.nhdr *.nrrd *.m mha i *.nii *.gz *.mgz *.img *.p "‘xgancell

spgr Centered Ignore Orientation LabelMap
Options:

¥| Single File




~ Access to MRML and Arrays

File
800 s
IRy T RS G [T L Run the following code in the
>>> a = slicer.util.array('spgr')
7 princ(a) Python console

B L

.. a=slicer.util.array('spgr’)

» The Main Window - Uses the slicer.util package to

: return a numpy array of the image

ST —>The variable 'a' is a numpy ndarray

T T of the volume data we just loaded
print( a)

—>Shows a shortened view of the array

¥ Data Probe




Access to MRML and Arrays

File Edit View Help

ﬁj Modules:

&) Welcome to Slicer

1000 , 00 0]
(131 ....222]
(113 ...,121]
(673 ....235]
(563 ....234]]
(000 ..., 000]
[000 .... 00 0]
(210 ....100]
221 ...,12 2]
(040 ....001 3]
(030 ....01 2]]]
— =

[

| NIEDl

» Display
» Mouse & Keyboard
» Documentation & Tutorials

» Acknowledgment

¥ Data Probe

-

AP O % & < | 4§ ~ [ Persistent Lo "‘b. v

The intensity values of the spgr

Image appear in the Python

console

mple Data




Access to MRML and Arrays

Lpse e e - o o o Type the following command to
IR - display the min and max
f1iunidy intensity value of the spgr image
[[00O0 ..., 00 0]

290100 : :

SO | print( a.min(), a.max() )
[0 40 . 01 3]

[030...,012]]) -

>>> print(a.min(),a.max()) 7,

—>Use numpy array methods
to analyze the data

» Acknowledgment L — Si=27530| = Y &% =—= R: 2.30 G == A: 13.77

¥ Data Probe

-



Access to MRML and Arrays

File Edit View Help

Modules: &Y Welcome to Slicer - o A @ ) : v

| mMin=0;Imax=355

4

(113 ...,121] i
(673 ..., 235]
(563 ..., 23 4]]
[[000 ..., 000]
[000 ..., 000]
[210...,100]
(221 ...,122] -
[040 ..., 01 3]
[030 ..., 012]]] L
>>> print(a.min(),a.max())
(0, 355) i
>>> ) ) ;
» Display
» Mouse & Keyboard
» Documentation & Tutorials
» Acknowledgment B REE== S:2753 |~ Y &% =——

¥ Data Probe

-




Manipulating Arrays

= . &

Run the following code in the Python console,
(indent each new line with 2 spaces)

«eem def toggle():
n = slicer.util.getNode('spgr')
a = slicer.util.array('spgr')
a[:] = a.max()/2. - a
n.GetlmageData().Modified()
print("Toggled')

toggle()

= “_\‘r\ N 4
{/\\\§> . 0%

// ? ‘.\ J
[lﬁ s ! Z

For practice: use up arrow and return
keys to execute toggle() over and over



Manipulating Arrays

File Edit View Help
@ Modules: &3 Welcome to Slicer $| - o A g;iﬁ. I A BA_ L IR Lo 8w oo SNIU == R

1555 def toggle ():
. = slicer.util.getNode('spgr')

1
:
- 1
1
!E ibslicer = slicer.util.array('spgr’) :
a[]-amx()/Z - a !
Welcome n.GetImageData () .Modified() :
print ('Toggled’) |
1
- 1
[Sicay Load DICOM Data [oacy Load Data >>> toggle() :
{#: Customize Slicer O Download Sample Data Togg'led :
FPI> :

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard
» Documentation & Tutorials

» Acknowledgment

¥ Data Probe

m ™M



The toggle function in more detail

def toggle():
Defines a python function
Body of function performs element-wise
math on entire volume
Easy mix of scalar and volume math
Telling slicer that the image data for node 'n’
has been modified causes the slice view windows
to refresh



Qt GUI in Python

Run the following code in the
Python console

b = qt.QPushButton("Toggle")
b.connect('clicked()', toggle)
b.show()

What do you think will happen when you
run this code? What about when you
push the button?



Result with button toggling

IR S:-27.53 |#1 1 |

»| @ 4+ |Axial + [spgr




Result with button toggling

CIR

»| @ | < |Axial $ | spgr




In More Detail

- Slicer uses PythonQt to expose the Qt library

- Sophisticated interactive modules can be written
entirely with Python code calling C++ code that is
wrapped in Python (e.g. Endoscopy, Editor,
SampleData, ChangeTracker, and other slicer
modules in the Slicer source code)

(*) Qt: http://qt.nokia.com
(**) PythonQt: http://pythonqt.sf.net /F.Link (MeVis)



# Hellopython
"

class
def (self, parent)
parent. title = “He
parent. categories = [ 1
parent . dependencie:
parent. contributors = [

1 # replace with “Firstnane Lastnane (0rg)
parent.helpText =

parent..acknowledgenentText =

¥ Help & Acknowledgement

# replace with organization, grant and thanks
self.parent = parent

Help | Acknowledgement

ey e tone) Example of scripted loadable extension for the HelloPython tutorial.

self.parent = slicer.quRMLWidget ()
self.parent. setLayout (qt.QVBoxLayout ())
self.parent. setMRHLScene slicer.mrmlScene)

else
self.parent = parent

self.layout = self.parent.layout()

self.parent. show()

def (self)
# Instantiate and connect widgets

# Collapsible button
dunmyCol lapsibleButton = ctk.ctkCollapsibleButton()
dunmyCol LapsibleButton. text =

T epout adartdoet ummyCatLaps oL chution) v A collapsible button
dunmyFormLayout = qt.QFormLayout (dummyCollapsibleButton)

Hello world

# Add vertical spacer
self.layout . addStretch(1)

# set loc as instance attribute
self.helloworldButtor LoWor1dButton

det tt (self)
qt.QMessageBox. information(slicer.util.mainWindow(),

JHellopython.py

PART B: INTEGRATION OF THE
HELLOPYTHON TUTORIALTO
SLICER4



HelloPython.py

X=8
File Edit Tools

elp
B ld@a LIk BE,

from _main__ import vtk, qt, ctk, slicer

ﬂ"&D'& gg

#
# HelloPython
#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roar‘ap for Medical Research, Grant U54 EBO05149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonwWidget
#

class HelloPythonwidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() [}

if not parent:

pen the file HelloPython.py
located in the directory HelloPython

# Helloworia putton

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print 'Hello world' in standard ouput."
dummyFormLayout.addWidget (helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloWorldButton = helloworldButton

def onHelloworldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), 'Slicer Python', 'Hello World!')

HelloPython.py 22,8 AL




Module
Description

Module GUI

Processing
Code

HelloPython.py

X =0
File Edit T

from _ main__ import vtk, qt, ctk, slicer
#

# HelloPython

#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roaf§nap for Medical Research, Grant US54 EBO©5149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonWidget
#

class HelloPythonWidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() %

if not parent:
self.setup()
self.parent.show()

def setup(self):
# Instantiate and connect widgets ...

# Collapsible button

dummyCollapsibleButton = ctk.ctkCollapsibleButton()
dummyCollapsibleButton.text = "A collapsible button”
self.layout.addwidget (dummyCollapsibleButton)

# Layout within the dummy collapsible button
dummyFormLayout = qt.QFormLayout(dummyCollapsibleButton)

# Helloworld button

hellowWorldButton = qt.QPushButton("Hello world")
helloworldButton.toolTip = "Print 'Hello world' in standard ouput."”
dummyFormLayout.addwWidget (hellowWorldButton)
helloWorldButton.connect('clicked(bool)', self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloworldButton = helloWorldButton

def onHelloWorldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), ‘'Slicer Python', ‘Hello World!')

LloPython.py 22,8 ALUM




Module Description

class HelloPython:
def _init__ (self, parent): <— constructor

parent.title = "Hello Python"

parent.categories = ["Examples"]

parent.dependencies = []

parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware)",
"Steve Pieper (Isomics)",
"Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"

parent.helpText = """

This code is Example of scripted loadable extension for the HelloPython tutorial.

provided in
the template

parent.acknowledgementText =

This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through
the NIH Roadmap for Medical Research, Grant U54 EB005149."" # replace with organization,
grant and thanks.

self.parent = parent



Module GUI

# HelloWorld button

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print ‘Hello world' in standard ouput.”
sampleFormLayout.addWidget(helloWorldButton)
helloWorldButton.connect(‘clicked(bool)’, self.onHelloWorldButtonClicked)




Processing Code

qt.QMessageBox.information(
slicer.util.mainWindow(),
'Slicer Python', 'Hello World!')




Integrating HelloPython

Open the side
panel and click

_
Add

General settings
e T Fi T Skip loading of: loadable modules (—disable-load

Extensions settings command-line plugins (—-disable-c.....co...C,
Cache settings
Python settings
Volume rendering Prefer Executable CLlIs:

Show hidden modules:

scripted loadable modules (--disable-scripted-loadakljle-mo

Temporary directory: P /tmp/Slicer

Additional module paths:

Select Module Settings
f the : :gscs-lc’raalgffsgmmes
rom ¥| Affine Registration

Edit -> Application &
Settings Dialog |

&) Welcome to Slicer -

A @ o Transforms @ /

Volumes Models Annotations

* Restart requested

'_ Reset H Restore Defaults




Integrating HelloPython

Add the path to the
directory containing

Y S folder
He”OPythOnpy e/pieper/Dropbox/O.‘.elloW OO0 D& @ @
(when selecting the e B |Wpe | DateModit

directory, the
HelloWorld.py file itself
will not be displayed)

4 »

Files of type: = x Cancel




3DSlicer

&\ Welcome to Slicer

HelloPython in Slicer

(™ QO Y O

All Modules

Z Annotations

& DICOM

4 Data

-~ Editor

@ Models

3¢ OpenlGTLinkIF
 Scene Views

4 Transforms

™ View Controllers
@ Volume Rendering
& Volumes

£\ Welcome to Slicer

Hello Python

Wizards
Informatics
Registration
Segmentation
Quantification
Diffusion

IGT

Filtering
Surface Models
Converters
Endoscopy
Utilities
Developer Tools
Legacy
Testing

Work in Progress

" "B Restart Slicer when prompted.
Hello Python is now in the

; Modules Menu, under the

oata category Examples

Hello Python Part C - Laplace
Hello Python Part D - Sharpen
T

T

I R

»
>
>
»
»
»
>
»
>
>
»
»
»
»
>

4




& - HelloPython in Slicer

n Modules: . [Hello Python s) - '\),Mf;? CIICk on Help and
{‘N Slicer
=4

~ Help & Acknowled ACknOWIGdgment
e ve gy v eGP VTS FoHh in the Hello Python module

Kitware Inc., Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and
Women's Hospital and was partially funded by NIH grant
3P41RR013218-12S1 (NAC) and is part of the National Alliance for
Medical Image Computing (NA-MIC), funded by the National Institutes
of Health through the NIH Roadmap for Medical Research, Grant U54
EB005149.

Contributors: Jean-Christophe Fillion-Robin (Kitware), Steve Pieper
(Isomics) and Sonia Pujol (BWH)

v A collapsible button

Hello world

Expand the ‘A Collapsible button’ tab,
and click on the Hello World button

v Data Probe

L
F
B

None RAS: (125.0, -125.0, 1.0),



3DSlicer

Part C:
Implementing the
Laplace™ Operator

*named after Pierre-Simon, Marquis de Laplace (1749-1827)




Overview

The goal of this section is to build an image
analysis module that implements a Laplacian filter

on volume data

Use gMRML widgets: widgets
that automatically track the
state of the Slicer MRML

scene
Use VTK filters to manipulate

volume data




HelloLaplace.py

X=0

File Edit Tools

SRR SE wh e =N

from _main__ import vtk, qt, ctk, slicer

s [ El
=

#
# HelloPython
#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roar’ap for Medical Research, Grant U54 EBO05149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonwWidget
#

class HelloPythonwidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() [}

if not parent:

pen the file HelloLaplace.py
located in the directory HelloPython

# Helloworia outton

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print 'Hello world' in standard ouput."
dummyFormLayout.addWidget (helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloWorldButton = helloworldButton

def onHelloworldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), 'Slicer Python', 'Hello World!')

HelloPython.py 22,8 AL




This code is
provided in
the template

Module GUI (Part 1)

def setup(self):

# Collapsible button

self.laplaceCollapsibleButton = ctk.ctkCollapsibleButton()
self.laplaceCollapsibleButton.text = "Laplace Operator"
self.layout.addWidget(self.laplaceCollapsibleButton)

# Layout within the laplace collapsible button
self.laplaceFormLayout = qt. QFormLayout(self.laplaceCollapsibleButton)

# the volume selectors

self.inputFrame = qt.QFrame(self.laplaceCollapsibleButton)
self.inputFrame.setLayout(qt.QHBoxLayout())
self.laplaceFormLayout.addWidget(self.inputFrame)
self.inputSelector = qt.QLabel("Input Volume: ", self.inputFrame)
self.inputFrame.layout().addWidget(self.inputSelector)
self.inputSelector = slicer.gMRMLNodeComboBox(self.inputFrame)
self.inputSelector.nodeTypes = ( ("vtkMRMLScalarVolumeNode"), ")
self.inputSelector.addEnabled = False
self.inputSelector.removeEnabled = False
self.inputSelector.setMRMLScene( slicer.mrmIScene )
self.inputFrame.layout().addWidget(self.inputSelector)



This code is
provided in
the template

Module GUI (Part 2)

self.outputFrame = qt.QFrame(self.laplaceCollapsibleButton)
self.outputFrame.setLayout(gt. QHBoxLayout())
self.laplaceFormLayout.addWidget(self.outputFrame)
self.outputSelector = qt.QLabel("Output Volume: ", self.outputFrame)
self.outputFrame.layout().addWidget(self.outputSelector)
self.outputSelector = slicer.gMRMLNodeComboBox(self.outputFrame)
self.outputSelector.nodeTypes = ( ("vtkMRMLScalarVolumeNode"), " )
self.outputSelector.setMRMLScene( slicer.mrmIScene )
self.outputFrame.layout().addWidget(self.outputSelector)

# Apply button

laplaceButton = qt.QPushButton("Apply Laplace")
laplaceButton.toolTip = "Run the Laplace Operator."
self.laplaceFormLayout.addWidget(laplaceButton)
laplaceButton.connect('clicked(bool)', self.onApply)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.laplaceButton = laplaceButton



In More Detail

CTK is a Qt Add-On Library with many useful
widgets, particularly for visualization and medical
imaging see http://commontk.org

Qt Widgets, Layouts, and Options are well
documented at http://qgt.nokia.com
gMRMLNodeComboBox is a powerful slicer widget
that monitors the scene and allows you to select/
create nodes of specified types (example: here we
use Volumes = vtkMRMLScalarVolumeNode)



B o Processing Code

_ laplacian = vtk.vtkimageLaplacian()
Add this laplacian.SetInput(inputVolume.GetimageData())
code laplacian.SetDimensionality(3)
laplacian.GetOutput().Update()



In More Detail

vtkimagelaplacian is a vtkimageAlgorithm operates
on vtkimageData (see )

vtkMRMLScalarVolumeNode is a Slicer MRML class
that contains vtkimageData, plus orientation
information ijkToRAS matrix (see http://
www.slicer.org/slicerWiki/index.php/

Coordinate systems)



In More Detail (Continued)

Global slicer package gives python access to:
1- GUI (via slicer.app)

2- modules (via slicer.modules)

3- data (via slicer.mrmlScene)

slicer.app.applicationlLogic() provides helper
utilities for manipulating Slicer state



Go To Laplace Module

e s~ 00 n sso .  Re-start Slicer and select

\ 7

All Modules @® R =1

: module. Note that

& picom
‘e : combobox is empty

4 Transforms B
I View Controllers =
@ Volume Rendering

§ Volumes File Edit View Help
£\ Welcome to Slicer

[ eemples . EETIT l Modules: ‘- | Hello Python Part C - Laplace & | ™ Q </ {h FAS ﬁ (-

Wizards Hello Python Part C - Laplace
Hello Python Part D - S rpen

O

—
“

T

Informatics

Registration
Segmentation
Quantification

K = “‘ 3DSlicer
Diffusion !
IGT

»
>
»
>
4
>
>
Filtering ’ » Help & Acknowledgement
Surface Models 4
>
>
4
>
>
>

Converters
Endoscopy ¥ Laplace Operator
Utilities
Developer Tools Input Volume: | Select a Volume [} =
Legacy
Testin
9 Output Volume: | Select a Volume =
Work in Progress > e

Apply Laplace




Add Volume Dialog

Wew Help
= Modules: £\ Welcome to Slicer 3| = AP O & 4 7 1| § v | Persistent o 5 -
5) "EL

£ - Select File -> Add Volume
Welcome

[Gitay Load DICOM Data ey Load Data
{#: Customize Slicer O Download Sample Data

v

About

v

The Main Window

v

Loading and Saving

v

Display

v

Mouse & Keyboard

v

Documentation & Tutorials

v

Acknowledgment

v Data Probe

n

None RAS: (125.0, -125.0, 1.0),



Add spgr.nhdr

y [ open |
Look in: ’E/home/pieper/Dropbox/O_work/HeIIoPython = ’ o (= O @ @ ‘]
P pieper Name v Size Type Date Modif
9 data " HelloPython-Progra...er-2012-03-08.pptx 7.7 MB pptx File 3/12/12 3::

| HelloPython-Program...utorial_spujol.pptx 6.5 MB pptx File 3/7/12 9:3!
| HelloPython.py 1 KB py File 9/9/10 3:0!

EMOPYLNON. 21D 6.4 MB zip File 3/12/12 3:.
4B spr.nhdr N 351 bytes nhdr File 9/9/10 3:0
e g 6.4 MB gz File 9/9/10 3:0°

Load the dataset spgr.nhdr
located in the directory
. HelloPython/

File name: | spgr.nhdr | 4 Open |

Files of :| All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *. *img *.p 2 || '
iles of type ’ ( r *.nhdr *.nrrd *.m mha i *.nii *.gz *.mgz *.img *.p "‘xgancell

spgr Centered Ignore Orientation LabelMap
Options:

¥| Single File




After Adding Volume

¥ Laplace Operator (1) Note that Input Volume combobox
Input Volume: | spgr autoselected new volume

Output Volume: spgr
(2) Create new volume for output

’ Create new Volume
Delete current Volume R

|‘ Apply Laplace |

(3) Run the module

Run the Laplace
Operator.



Laplace Module

o -oom e _Result of Laplace Operator

@ Modules: _ | Hello Python Part C - Laplace | %

@ 3DSlicer

» Help & Acknowledgement

¥ Laplace Operator

Input Volume: | spgr 3

Output Volume: [Volume s

[ Apply Laplace N

Run the Laplace
Operator.

¥ Data Probe
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Overview

The goal of this section is
to add a processing option
for image sharpening.
We’'ll implement this
operation using the
existing Slicer Command
Line Module

‘Subtract Scalar Volumes’




HelloSharpen.py

X=0

File Edit Tools

SRR SE wh e =N

from _main__ import vtk, qt, ctk, slicer

s [ El
=

#
# HelloPython
#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roar’ap for Medical Research, Grant U54 EBO05149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonwWidget
#

class HelloPythonwidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() [}

if not parent:

pen the file HelloSharpen.py
located in the directory HelloPython

# Helloworia outton

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print 'Hello world' in standard ouput."
dummyFormLayout.addWidget (helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloWorldButton = helloworldButton

def onHelloworldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), 'Slicer Python', 'Hello World!')

HelloPython.py 22,8 AL




Add to Module GUI

Add this self.sharpen = qt.QCheckBox("Sharpen", self.laplaceCollapsibleButton)

Text in self.sharpen.toolTip = "When checked, subtract laplacian from input volume"
) self.sharpen.checked = True

section A self.laplaceFormLayout.addWidget(self.sharpen)



& Add to Processing Code

Add this #optionally subtract laplacian from original image

) if self.sharpen.checked:

TeXt,'n parameters = {}

section B parameters['inputVolume1'] = inputVolume.GetID()
parameters['inputVolume2'] = outputVolume.GetlD()
parameters['outputVolume'] = outputVolume.GetlD()
slicer.cli.run( slicer.modules.subtractscalarvolumes, None,

parameters, wait_for _completion=True )



In More Detail

slicer.cli gives access to Command Line
Interface (CLI) modules

CLI modules allow packaging of arbitrary C++
code (often ITK-based) into slicer with
automatically generated GUI and python
wrapping



File Edit View Help

@ Modules: .
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&

Welcol

S
Load DICOI
(Gicsy Load Dicom |

{8 Customize Sli
1& ustomize j

| » About

B |
‘ » The Main Window |
| » Loading and Saving b |
| » Display
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| » Mouse & Keyboard D |
| » Documentation & Tutorials B
‘ » Acknowledgment A
v Data Probe 1

Go To Sharpen Module

&) Welcome to Slicer

“

All Modules

[# Annotations

& picom

A Data

/. Editor

@ Models

Fa Scene Views

4 Transforms

I view Controllers
@ Volume Rendering
§ Volumes

£\ Welcome to Slicer
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Wizards
Informatics
Registration
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Diffusion

IGT

Filtering
Surface Models
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Endoscopy
Utilities
Developer Tools
Legacy

Testing

Work in Progress
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[Sarc; Load Data

Jownload Sample Data
.

Hello Python ‘
Hello Python Part C - Laplace

T

r

n

Re-start Slicer and select
module. Note the new
sharpen check box

Output Volume: \ Select a Volumi

¥ Sharpen

_{When checked,
subtract laplacian
from input volume




Add Volume Dialog

Wew Help
= Modules: £\ Welcome to Slicer 3| = AP O & 4 7 1| § v | Persistent o 5 -
5) "EL

£ - Select File -> Add Volume
Welcome

[Gitay Load DICOM Data ey Load Data
{#: Customize Slicer O Download Sample Data

v

About

v

The Main Window

v

Loading and Saving

v

Display

v

Mouse & Keyboard

v

Documentation & Tutorials

v

Acknowledgment

v Data Probe

n

None RAS: (125.0, -125.0, 1.0),



Add spgr.nhdr

y [ open |
Look in: ’E/home/pieper/Dropbox/O_work/HeIIoPython = ’ o (= O @ @ ‘]
P pieper Name v Size Type Date Modif
9 data " HelloPython-Progra...er-2012-03-08.pptx 7.7 MB pptx File 3/12/12 3::

| HelloPython-Program...utorial_spujol.pptx 6.5 MB pptx File 3/7/12 9:3!
| HelloPython.py 1 KB py File 9/9/10 3:0!

EMOPYLNON. 21D 6.4 MB zip File 3/12/12 3:.
4B spr.nhdr N 351 bytes nhdr File 9/9/10 3:0
e g 6.4 MB gz File 9/9/10 3:0°

Load the dataset spgr.nhdr
located in the directory
. HelloPython/

File name: | spgr.nhdr | 4 Open |

Files of :| All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *. *img *.p 2 || '
iles of type ’ ( r *.nhdr *.nrrd *.m mha i *.nii *.gz *.mgz *.img *.p "‘xgancell

spgr Centered Ignore Orientation LabelMap
Options:

¥| Single File




After Adding Volume

7 Laplace Operator (1) Note that Input Volume combobox
Input Volume: | spgr autoselected new volume

Output Volume: spgr

‘ Create new Volume
Delete current Volume R

(2) Create new volume for output

(3) Run the module in Sharpen

¥ Sharpen mode

Run the Laplace or
Sharpen Operator.
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Sharpen Module

ﬁlfeﬂgd!ieéue:odu[esz ©, [Hello Python Part D - Sharpen | 4 | - G. QI A § O @ 7 .
T e Sharpening Operator on

3DSlicer

@®

» Help & Acknowledgement

¥ Sharpen Operator

¥| Sharpen

Input Volume: ‘ spgr

Output Volume: | Volume

Apply

¥ Data Probe

m

Result of Laplacian




& o Sharpen Module

Adjust Window/Level with

B& |Modules: O [HelloPython PartD-sharpen (2] ™ Q) © |1 &4 § @ @& @ 2 i .
2 Left-Mouse-Drag in Slice
d 3DSlicer .

» Help & Acknowledgement

¥ Sharpen Operator

Input Volume: | spgr s

Output Volume: | Volume s

¥! Sharpen

Apply

¥ Data Probe

-




Image Sharpening

3DSlicer

&

Laplacian filtered

Laplacian

original




Going Further

Explore numpy for numerical array manipulation

Review Endoscopy Module for interactive data
exploration using MRML and VTK

See the Editor Module for interactive
segmentation examples

Explore SimplelTK for image processing using ITK



3DSlicer

Conclusion

This course demonstrated how to
program custom behavior in Slicer
with Python

& @ python’

3DSlicer
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